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1 Introduction

A System Monitor is a web application that participates in an I-Technology Inc. Central Data
environment. It acts to handle System Messages and provide oversight on the operation of
the components of the system.

1.1 Application Operation

Central Data Applications participate in a publish and subscribe regime whereby they
publish data to a wider audience and subscribe to data coming from other participants.
In aid of this, the application needs a Publisher object that will establish a connection
with a Data Broker and transmit the data to be published.

The application also requires a Subscriber Task that establishes a socket connection to
the Broker, informs it of the data types that it is subscribing to and watches the socket
for any published data. When data is received, the subscriber passes it on in an inter-
task queue.

The System Monitor is a Python application that stores and displays operating
information.

System messages are described in Appendix A and B. Some generated by applications
and subscribed to by the System Monitor. Some are generated by the System Monitor to
elicit responses from applications.

The System Monitor provides a user interface to allow the user to monitor various
aspects of the systems operation and to effect changes.

1.1.1  System Monitor Functions

The System Monitor will be a web application deployed on an Apache Tomcat server. It will perform the
following functions:

1. Monitor the status of applications in the system.

2. Keep a record of and provide when required, the parameters for each application.
3. Monitor error messages from applications and generate alerts.

4. Provide debug logging information from applications.

5. Synchronize applications by acting as a Time Server.

6. Keep track of the versions of the applications running in the system.

These functions are made possible by the System Messages. Event Types (9000000.00 — 9999999.99) are
reserved for System Data. These events are defined in the table below. Those relevant to the System Monitor
are marked with an asterisk

© Copyright 2014 |-Technology Inc. @ @ N F H D E N T HA L 1
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System Events

Type Name Issuing Event
9000000.00* | Started Issued when an application has started
9000001.00* | Stopping Issued when an application is shutting down
9000010.00* | Ping Issued by the System Monitor to determine if an
application is still operating.
9000011.00* | Ping Response from the application being pinged.
Response
9000020.00* | Error Used to alert about faults an application has experienced.
9000025.00 | Notice of Issued by a dependant micro-service when an expected
Failure response is not received.
9000030.00* | Status Used to send a global message to all applications.
9000040.00* | Time A Timestamp used to synchronize an application with other

applications in the system. Issued by the System Monitor
on request.

9000041.00*

Time Request

Issued by an application when it needs to synchronize with
the system.

9000060.00* | Parameter Issued by an application requesting it's parameters from
Request the System Monitor
9000061.00* | Parameters Sent by the System Monitor in response to a Parameter

Request

9000080.00*

Data Definition

A Subscriber when connecting with a Broker.

The System Monitor in response to a Version Request.
The data will be the XML documents that describe each
version of the data type in the Version Request

9000085.00

Query Report

Published by the Librarian when it receives a query

Note:

Appendix | will detail the syntax of these various messages.

1.1.1.1

1.1.1.1.1 Log On

System Monitor Application

The Log on screen is shown in the markup below.

© Copyright 2014 |-Technology Inc.
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System Monitor

I-Technology Inc. Lego 600 x 5O

System Monitor

User Name | UserName here |

Hlustration 1: System Monitor Log On Screen

1.1.1.1.2 Devices /Applications Monitoring

Devices and Applications are handled on the Devices/Applications Screen.

© Copyright 2014 |-Technology Inc. @ © N F H D E N T HA L
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Hllustration 2: System Monitor Devices & Applications

System Monitor
I-Technolagy Inc. Logo 600 x 50
_—
File » Help » Logout
Devices/Applications | Error AJerts'Data Deﬁmtions' Subscriptions | F’arameters‘
Devices
Device ID |Ext J P |fgxt Status Eene]
. Running —
Location Name IP. Status v
Main Office N Door Controller 192.168.155 Running
Main Office E Door Controller 192.168.156 Running E
Main Office W Door Controller 192.168.157 Stopped
Applications
Application IO Faxt —| | By | | Ping Al O Show Only Applications With Current Errors
Device Application Version | Status Level |Started Action
Door Lock 100 FIRE |1 |2013-02-03TO ”
Security Conraller Blass Break Monitor 32 FIRE |1 |2013-02-03T04:05:00-0500 -
.
Alerts Show Alerts for the last 10/ Hrs Reset | | cl | Runni
= lear unmng. Has Errors D Stopped .
Type |Level  |Action [Time Description
25 Mormal |2 2013-02-03T04:05:00-0600 Wnable to Connect &
404 [Mormal |2 2013-02-03T04:085:00-0500 Page not found E
58 Verbose |34 2013-02-02T04:05:00-0600 Mo records found .
Grids:

1. Devices — A table of devices compiled from deviceName and location fields in Started
[9000000.00] or Ping Response [9000011.00] messages or Ping Response [9000011.00].

2. Applications — A table of applications compiled from deviceName and application Name fields
in Started [9000000.00] or Ping Response [9000011.00] messages or Ping Response
[9000011.00].

3. Alerts — From a table of alert messages from Error [9000020.00] messages.

Buttons:

1. Search — Filters the associated grid based on the contents of the text fields.

2. Ping — Publishes a Ping [9000010.00] message addressed to the device and application.

3.

© Copyright 2014 |-Technolo
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applications.
4. Reset — Resets the Alerts grid filter to show only new messages.
5. Clear — Clears the Alerts grid filter. (Shows all alerts).

1.1.1.1.3 Parameter Inventory

The Set Parameters and Get Parameters buttons on the Devices and Applications tab will handle the parameters
for the selected application.

I-Technology Inc. Logo 600 x B0 _‘______L_‘_‘_‘_‘_‘_‘%_‘—
File + Help » Logout
Devices/Applications | Error Alerts | Data Definitions I Subscriptions | Parameters |
Parameters Device |1'exi' | Application [taxt ] | Search
Device ication Paramsters
Apel T~ | Get P -t | | Set Parameters |
Broker Server Broker 12
Archive Server Archivist 16 Key Value
Librarian Server Librarian 12 cassandra host 127.001 o
cassandra.port 2160
cassandra.keyspace archive
N 2
New | | Update | | Delete

Hllustration 3: System Monitor - Parameters

Grids:
1. Parameters — A table of parameters compiled from the fields in Parameters [9000061.00]
messages.
2. Parameter Values — A table of parameter values compiled from the fields in Parameters
[9000061.00] messages. (Linked to the table above)
3. Alerts — From a table of alert messages from Error [9000020.00] messages.
Buttons:

1. Search — Filters the associated grid based on the contents of the text fields.

© Copyright 2014 |-Technology Inc. @ © N F H D E N T HA L 5
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1.1.1.1.4

2.

Get Parameters — Publishes a Parameter Request [9000060.00] message addressed to the device
and application.

Set Parameters - Publishes a Parameter Set [9000062.00] message addressed to the device and
application based on the current values in the parameters and parameter values tables.

New — Creates a new record in the associated grid.
Update — Changes data in the selected row of the associated grid..

Delete — Deletes the selected parameter or parameter value from the associated grid.

Error Reporting

A library will be provided similar to log4;j. It will send all log messages defined in code by the programmer out

as a system message [9000020.00]. These messages are subscribed to by the System monitor and handled by
the error logger.

Errors will be handled on the Error Alerts Page.

System Monitor
I-Technology Inc. Logo 600 x 50 _____________-_-_-_-_-_‘_‘_-_-_‘
File » Help » Logout
Davices/Applications ‘ ErrorAIerts|Data Deﬁnit\ons| Subscriptions | F’arameters‘
Error Alerts
Device Application |Text | Type |fext | Time |faxt | | Search |
Show Alerts for the last 105 Hrs = | Reset || Clear |
Ne. |Deviee Application Type |Level |Time Action |Description
1 [N Door Caniroller Door Lack 25 [Normal | 2013-02-03T04:05:00-0500 | 2 Unable to Connect 121
2 |Security Controller Glass Break Monitor 404 |Normal | 2013-02-03T04:05:00-0500| 2 Unable to Connect O
3 |Comms Module Phopetiall A e ST A QE0AL34 Unable to Connect M

Comms Module: 00-14-22-01-23-45
Phone Dialler: 046b6c7f-0b8a-43b9-b35d-6489%ebdaee91

Dialog box launched on a right
o= click. Shows detail of selected

L record

Clear Selected Clear All

Hllustration 4. System Monitor Error Alerts

© Copyright 2014 |-Technology Inc. @ © N F H D E N T HA L 6
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Grids:
1. Error Alerts — From a table of alert messages from Error [9000020.00] messages.

Buttons:
1. Search — Filters the associated grid based on the contents of the text fields.

Reset — Resets the Alerts grid filter to show only new messages.

2

3. Clear — Clears the Alerts grid filter. (Shows all alerts).

4. Clear Selected — Clears those messages selected using the check-boxes.
5

Clear All — Clears all messaages from the grid.

1.1.1.1.5 Debug/Trace Monitor
Debug messages will be sent to the System Monitor if the application status is set to Verbose. These messages
will appear on the Error Alert tab.

1.1.1.1.6 Time Server

The System Monitor will respond to Time Request message by replying with a Time message. Systems will be
time synchronized with an error proportionate to the transaction delay.

© Copyright 2014 |-Technology Inc. @ @ N F H D E N T HA L



Wl ”{_‘_
[# I-Technology Inc.

System Monitor Specification

1.1.1.1.7

Data Definitions

Data Definitions are catalogued on the Data Definitions Tab.

System Monitor

I-Technology Inc. Logo 600 x B0 _________ER
File : Help » Logout
Devices/Applications ‘ Error Alerts | Data Deﬁnmonsl Subscriptions | Parameters
Data Definitions
Data Type Name “Passwwd Fiolds bata Type | |
50050200.00 invoiceDetail AB48s:34 E Name | | | Search
50050230000 inventory bDESETBE |10 Fields
50050300.01 inventoryCount DCBIET be 1 Ne. N \I: fault Valug
1 id lu ™
2 description o
3 category null
v v
Delete Selected Definition

Hllustration 6: System Monitor - Data Definitions

Grids:

Data Definitions — From a table of Data Definitions from Data Definition [9000080.00]

messages.

Data Definition Field Values - From a table of Data Definition Field Values from Data
Definition [9000080.00] messages. Shows those fields associated with the selected Data

Definition.

Buttons:

1.

2. Delete Selected Definition — Deletes the selected data definition from the table.

3.

Search — Filters the associated grid based on the contents of the text fields.

Clear All — Clears all messaages from the grid.

© Copyright 2014 |-Technology Inc.
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1.1.1.1.8 Subscription Monitor

Subscriptions are tracked on the Subscriptions tab.

System Monitor

I-Technology Inc. Logo 600 x 50

File * Help » Logout

Devices/Applications | ErrorAIerts'Data Deﬁnitions'Suhscriptions | Parameters|

Device Application |Taxt | Date |Taxt |
S r— Y = |

Subseriptions

Device Application Date Data Type IP. Address Local Port
N Door Controller Door Lack 2013-02-03T04:05:00-0500 | 50050400.00 192.168.156 gooz  |°
Security Controller Glass Break Monitor 2013-02-03T04:05:00-0600 | 50050400.00 102.168.156 2003
Comms Module Phone Dialler 2013-02-03T04:05:00-0600 | 50050400.00 192.168.156 8003

lllustration 7: System Monitor Subscriptions Tab

Grids:

1. Subscriptions — From a table of Subscriptions from Subscription List [9000056.00] messages
received in response to System List Request [9000055.00] messages.

Buttons:

1. Search — Filters the associated grid based on the contents of the text fields.

© Copyright 2014 |-Technology Inc. @ © N F H D E N T HA L 9
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Appendix A XML Message Formats
A 1. Publication

Each publisher is identified by it's socket information (IP Address and Port). If multiple applications are deployed (on

a web server for example) the developer must make each one unique by using different ports.

A.1.1 Publication DTD

The DTD below describes the xml for a publication:

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE packet]

<IELEMENT packet (publisherld, metadata, dataRecord)>
<IELEMENT publisherld (date, ipAddr, localPortNo)>
<IELEMENT metadata (recordNo, type, date, status, creator, link, tenant, fieldCount)>
<IELEMENT recordNo (#PCDATA)>

<IELEMENT type (#PCDATA)>

<IELEMENT date (#PCDATA)>

<IELEMENT status (#PCDATA)>

<IELEMENT creator (#PCDATA)>

<IELEMENT link (#PCDATA)>

<IELEMENT tenant (#PCDATA)>

<IELEMENT fieldCount (#PCDATA)>

<IELEMENT dataRecord (field+)>

<IELEMENT field (fieldNo, data)>

<IELEMENT fieldNo (#PCDATA)>

<IELEMENT data (#PCDATA)>

<l--The IP address of the source-->

<IELEMENT ipAddr (#PCDATA)>

<l--The local port number of the source-->
<IELEMENT localPortNo (#PCDATA)>

>

© Copyright 2014 |-Technology Inc. @ @ N F H D E N T HA L
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example:

<packet>
<publisherld>
<date> 2013-02-03T04:05:00-0500 </date>
<ipAddr>192.168.1.68</ipAddr>
<localPortNo>4003</localPortNo>
</publisherld>
<metadata>
<recordNo>dfe010d0-e805-11e2-8ba9-68b599e2e914</recordNo>
<type>50050200.00</type>
<date>2011-02-03T04:05:00-0500</date>
<status>0</status>
<creator>"DemoUser’</creator>
<link>0</link>
<tenant>5</tenant>
<fieldCount>3</fieldCount>
</metadata>
<dataRecord>
<field>
<fieldNo>1</fiel[dNo>
<data>"12345"</data>
</field>
<field>
<fieldNo>2</fiel[dNo>
<data>"Smith"</data>
</field>
<field>
<fieldNo>3</fieldNo>
<data>"Robert’</data>
</field>
</dataRecord>
</packet>

Appendix B Librarian Queries

The following example details a query to the Librarian.

<9000010.00> # Query for data records of type 9000010.00
<0> # Query for all records in the Archive
Proposal:

<applicationld>
<applicationName>
<deviceld><
deviceName>
<userName>

© Copyright 2014 |-Technology Inc. @ @ N F H D E N T HA L
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<tenantld>

<74beb9bf-b314-458f-bdbe-bc5e2dfede28>

© Copyright 2014 |-Technology Inc.

CONFIDENTIAL

12



Wl ”{_:.
-—f?‘- %-. I-Technology Inc. System Monitor Specification

Appendix C System Data Messages

System Data Messages are created in the same format as Publications which are detailed in Section 1 above. The tables
below detail the fields in the various System Data Messages. The identity of an application will be determined using two
fields:

L. The MAC address of the application’s host
2. A UUID generated by the application developer that will uniquely identify the application

The application may have several implementations on different machines and a web server may host several applications.

C.1.1 Started [9000000.00]

Field | Field Name Data Type Description
#
1 devicelD String Mac Address
2 deviceName String Device name
3 location String Device Location
4 applicationID byte(16) UUID assigned by developer
5 applicationName | String The name of the application
6 StartTime Timestamp Local Start Date/Time
7 Subscriptions String List of records subscribed to
8 Publications String List of records published
9 pid Integer The Process ID

C.1.2 Stopping [9000001.00]

Field | Field Name Data Type Description
#
1 devicelD String Mac Address
2 deviceName String Device name
3 Location String Device Location
4 applicationID byte(16) UUID assigned by developer
5 applicationName | String The name of the application
6 stopTime Timestamp Local Stop Date/Time
7 pid Integer The Process ID

© Copyright 2014 |-Technology Inc. @ @ N F H D E N T HA L
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C.1.3 Power Loss [9000005.00]

Field | Field Name Data Type Description
#
1 vin float Voltage In
2 vbat float Battery Voltage
3 vout float Voltage Out

C.1.4 Power Restored [9000006.00]

Field | Field Name Data Type Description
#
1 vin float Voltage In
2 vbat float Battery Voltage
3 vout float Voltage Out
C.1.5 Powering Off [9000007.00]
Field | Field Name Data Type Description
#
1 vin float Voltage In
2 vbat float Battery Voltage
3 vout float Voltage Out
C.1.6 Ping [9000010.00]
Field | Field Name |Data Type Description
#
1 pingType Integer 0 =all, 1 = device, 2 = application
2 devicelD String Mac Address
3 applicationID |byte(16) UUID assigned by developer
4

© Copyright 2014 |-Technology Inc.
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C.1.7 Ping Response [9000011.00]

Field | Field Name Data Type Description

#
1 devicelD String Mac Address
2 deviceName String Device Name
3 location String Device Location
3 applicationID byte(16) UUID assigned by developer
4 applicationName | String The name of the application
5 pingTime timestamp UTC Date/Time of response
6 pid Integer The Process ID

C.1.8 Error [9000020.00]

Field | Field Name Data Type Description
#
1 devicelD String Mac Address
2 deviceName String Device Name
3 applicationID byte(16) UUID assigned by developer
4 applicationName | String The name of the application
5 errorType Integer Error Code defined by Developer
6 errorLevel Integer Error Level for Verbosity filtering
7 ErrorAction Integer Action code:
0 — Display
1 — Email Alert Level 1
2 — Email Alert Level 2
3 — Email Alert Level 3
4 — Page Alert
5 — Syslog Alert
8 errorText String Description of the Error

C.1.9 Notice of Failure [9000025.00]

Field

Field Name

Data Type

Description

© Copyright 2014 |-Technology Inc.
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System Monitor Specification

1. Message [.D. UUID I.D. of the initiating message

2. Session 1.D. UUID Session Identifier

3. Response List List Expected Response(s)

4. Responding UUID Application I.D. of responding service
Service

5. Initiating String The message not responded to
Message

C.1.10 Status [9000030.00]

Field | Field Name Data Type Description
#
1 devicelD String Mac Address
2 applicationID | byte(16) UUID assigned by developer
3 StatusLevel Integer Priority — 10 = highest
4 StatusNumber | Integer A unique number identifying the kind
of status.
5 StatusMessage | String Text of the Status Message

C.1.11 Time [9000040.00]

Field | Field Name |Data Type Description
#
1 devicelD String Mac Address
2 applicationID |byte(16) UUID assigned by developer
3 Time Timestamp System Time for synchronization
4
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C.1.12 Time Request [9000041.00]

Field | Field Name |Data Type Description
#
1 devicelD String Mac Address
2 applicationID |byte(16) UUID assigned by developer
3
4

C.1.13 Parameter Request [9000060.00]

Field | Field Name Data Type Description
#
1 devicelD String Mac Address
2 applicationID byte(16) UUID assigned by developer
3
4

C.1.14 Parameters [9000061.00]

Field | Field Name Data Type Description
#

1 devicelD String Mac Address

2 deviceName String Device Name

3 applicationID byte(16) UUID assigned by developer

4 applicationName | String The name of the application

5 parameterCount Integer # of Parameters

6 Parameter™
parameterKey String Key name of Parameter
parameterValue | String Parameter Value

* Repeating Key-Value Pair
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C.1.15 Configuration Update/Read File [9000070.00]

Field | Field Name Data Type Description
#
deviceld String Mac Address
deviceName String Device Name
location String Device Location as set by installer
applicationld byte(16) UUID assigned by developer
1 applicationName | String The name of the application
2 authorization Integer 0 = non required, 1 = required
3 action Integer 0 = do nothing, 1 = compare, 2 = update only,
3 =update and reboot, 4 = readFile only
4 fileName String The name of the file to be updated
5 fileLocation String Path to the file to be updated
6 checksum Integer Checksum of the file to be read for readFile
command

C.1.16 Configuration Update/Read Status [9000071.00]

Field | Field Name Integer Description
#
1 errorCode String 0 = successful, x = error code
2 fileName String The name of the file to be updated
3 checksum Integer Checksum of the file to be read for
readFile command
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C.1.17 Data Definition[9000080.00]

Field | Field Name |Data Type Description
#
1 recordld Double The data type and version
2 date timestamp Date the definition was created
3 dataDefinition | String JSON encoding of an object

describing this data type (See
Appendix C1)

C.1.18 QueryReport [9000085.00]

Field | Field Name |Data Type Description
#
1 user String User ID/ Name
2 limit Integer Number of results limit
3 tenant UUID UUID assigned by developer
4 startDate timestamp Date/ Time for range start
5 endDate timestamp Date/ Time for range end
6 queryTerms | String String representation of filter
conditions
7 Results Integer Number of results returned
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Appendix D Change Management Strategy
The definition of a data record could undergo the following changes:
* A field could be added to the record.
* A field could be deleted from the record.
* A field in the record could be changed to a different data type.

‘ In order to determine that one record type replaces another, we will alter the record version number.

New fields will always be appended to the definition so as to minimize disruption to existing code. This will maintain
backward compatibility.

D.1 Merge

The Broker will handle the translation of data from one version to another. If a subscription is for one version,

and another version is published, the Broker will implement the merge strategy for that data type and supply the
Subscriber with data compatible with its requested version. It is the responsibility of the Application Developer

to supply conversion syntax whenever a new version of the data is implemented. The map will consist of an
XML string that is a copy of the data type's normal string except that the data supplied will be the default
values.

e.g.
Original Version

<data Definition>
<type>50050200.00</type>
<recordName>invoiceDetail</recordName>
<fieldCount>3</fieldCount>
<dataRecord>
<field>
<fieldNo>1</fieldNo>
<name>id</name>
<data>0</data>
</field>
<field>
<fieldNo>2</fieldNo>
<name>description</name>
<data>""</data>
</field>
<field>
<fieldNo>3</fiel[dNo>
<name>units</name>
<data>""</data>
</field>
</dataRecord>
</data Definition>
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New Version

<data Definition>
<type>50050200.01</type>
<recordName>invoiceDetail</recordName>
<fieldCount>4</fieldCount>
<dataRecord>
<field>
<fieldNo>1</fiel[dNo>
<name>id</name>
<data>0</data>
</field>
<field>
<fieldNo>2</fieldNo>
<name>description</name>
<data>""</data>
</field>
<field>
<fieldNo>3</fiel[dNo>
<name>units</name>
<data>""</data>
</field>
<field>
<fieldNo>4</fieldNo>
<name>quantity</name>
<data>0</data>
</field>
</dataRecord>
</data Definition>

Notes:

1. Java data type conversions are handled by the Subscriber since all data is received as ascii and is
translated by the application into the appropriate data type.

2. When a new version omits a field, the original field numbering is retained with a gap for the missing
data.
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